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This document
This document provides a 
step-by-step technical and 
practical manual on how to 
build and implement the 
Space Syntax Simplified 
Analytical toolbox, described 
in D1.6. 

The Space Syntax simplified analytical 
toolbox workflow is an iterative 
process. 

The six steps summarised in the 
diagram in the following page can be 
repeated as many times as needed to 
diagnose the existing conditions and test 
different scenarios.

The first steps provide guidance on how 
to collect, process, combine and 
visualise data, that addresses local 
SUMP priorities. The final steps focus on 
the interpretation of the analysis and 
further scenario testing. 

A feedback loop is included in the 
process, allowing users to review 
modelling results and inform the 
optimisation of scenarios in an iterative 
process.

To implement the toolbox workflow, 
QGIS (2.14 or above), depthmapXnet
and Space Syntax Toolkit for QGIS, are 
required, all of which are available as 
open-source.

Overview
The Simplified analytical toolbox 
contains a set of tools and 
processes that perform fundamental 
GIS operations on spatial data. 

As part of SUMP PLUS and through 
the collaboration on the city-led 
innovation labs, Space Syntax 
provided a set of analytical tools and 
developed a simplified workflow, 
suitable for most smaller cities who are 
developing sustainable mobility 
strategies, based on datasets that are 
typically available through open 
sources or through the municipalities.

The toolbox workflow can be 
performed with relative ease and 
with limited availability of data. It 
enables smaller cities and 
stakeholders working on a SUMP, to 
carry out and test their own spatial 
analysis. The workflow is structured to 
create a simplified version of an 
Integrated Urban Model. 

The toolbox workflow is open-source 
and has been adapted for users of all 
skill levels (basic GIS knowledge 
required) without the need to code or 
script. 

How to use the manual
The manual is structured in chapters 
that follow the six key steps of the 
toolbox workflow. 

Throughout the manual, there are 
examples from the Platanias study, 
highlighted in grey. 

Links and references to supporting 
documents are provided in some 
steps, as required. 

When carrying out the toolbox 
workflow, it is important to create an 
accompanying spreadsheet. This is 
to store data sources, index tables, 
abbreviations, fields names etc. This is 
useful to reference at any stage of the 
workflow. This can be done on a 
spreadsheet software, such as a 
Microsoft Excel.

Bibliography and references can be 
found at the end of the manual. This 
also includes information on where to 
access support from the Space Syntax 
research and education communities.

D1.6 Space Syntax simplified analytical toolbox  
Introduction
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1. Inception
Development of priorities and indexes for the 
SUMP PLUS analysis, data collection, 
downloading required software, additional 
Space Syntax and QGIS training provision, 
as required depending on existing team skills.

2. Spatial Modelling
Production of the two key types of analysis, 
Spatial Accessibility Analysis (SAA) and 
Metric Catchment Analysis (MCA), using 
Space Syntax open-source tools.

3. Combinational Analysis
Integration of processed spatial models and 
other datasets to produce a combinational 
analysis of user-focused outputs.

4. Index parameter setting
Defining the index parameters and 
aggregating final scores for each index, 
based on the priorities set out in Step 1.

5. Exporting and visualisation
Visualisation of indexes in QGIS.

6. Interpretation of results
Evaluation of the results in the context of and 
to inform the development of SUMP 
measures. This helps to highlight the priority 
areas, the easy wins and the areas lacking in 
facilities or spatial accessibility. 
Following the diagnosis of the existing 
conditions, scenarios can be tested and 
objectively compared and assessed through 
the scoring of the indexes (feedback loop in 
workflow diagram).

Spatial Modelling
Spatial Accessibility Analysis Metric Catchment Analysis

Inception
Space Syntax and 
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Combinational analysis
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Development of priorities 
and indexes for the SUMP 
The development of the priorities for 
the SUMP will define the indexes and 
their key parameters.  Depending on 
the priorities of the city for the 
SUMP, the indexes could include 
walkability, cyclability, active travel, 
sustainable tourism etc.

This will guide the process of the 
data collection and will define the 
parameters of each index i.e. access 
to public transport, pedestrian 
infrastructure, amenities and social 
infrastructure etc. are important 
parameters for the walkability index. 

Data Collection
Based on the priorities defined, the 
data collection focuses on relevant 
data availability. 

The core data for the spatial analysis is 
a street network, often referred as a 
Road Centre Line (RCL) model. The 
local government or city planning 
team might have their own public data 
directory for downloading spatial data. 
Other open-source data packages can 
be found on OpenStreetMap and 
Geofabrik. Contributions and edits are 
community-maintained.

Once data and data packages have 
been identified, it is important to check 
files contain geographic properties. It is 
recommended to download data files in 
GIS shapefile format and CSV 
(comma-separated values) files that 
have geographic information such 
as longitude (x), latitude (y) 
coordinate columns.

Alternatively, if data is unavailable a 
desktop study can be created. Use 
Google My Maps to categorise and 
pinpoint locations, draw polygons and 
lines, which can later be imported as a 
KML file in to QGIS.   
https://www.google.co.uk/maps/about/
mymaps/

Software download
To implement the toolbox, QGIS (2.14 or 
above), depthmapXnet and Space Syntax 
Toolkit for QGIS are required. These are 
open-source and available to download:

QGIS (2.14 or above)
QGIS is an open-source software platform 
to perform a set of geographical 
information system (GIS) analysis. 
Download based on your operating system.
https://qgis.org/en/site/

Space Syntax Toolkit for QGIS
The plug-in can be installed from the QGIS 
Plugins Manager. It provides a front-end 
for the DepthmapX software within QGIS, 
for seamless spatial network analysis. 
Installing Space Syntax Toolkit is part of 
the process in step 2. A detailed 
explanation on the requirements and how 
to install it is on page 15. 

depthmapXnet
This compiled version is used for the 
Space Syntax Toolkit analysis. 
Downloading depthmapXnet is part of the 
process in step 2. A detailed explanation 
on the requirements and how to download 
is explained on page 25.

An additional spreadsheet software, 
such as Microsoft Excel, is also 
recommended.

Space Syntax and GIS training
Whilst this document provides a detailed 
manual for the toolbox, additional 
resources are referenced. These cover the 
fundamentals of Space Syntax theory and 
techniques. Key resources are listed below:
UCL Space Syntax Online Training 
Platform (open-source)
Introduces the fundamentals of Space 
Syntax theory and provides a unified 
training resource for researchers and 
practitioners.
https://www.spacesyntax.online

Space Syntax YouTube channel
Introduction, keynotes and training videos 
on the Space Syntax approach 
https://www.youtube.com/user/spacesyntax
dotcom

Space Syntax Training
Training packages for individuals and 
organisations in the use of the Space 
Syntax approach: from one-off executive 
training events to multi-session courses.
https://spacesyntax.com/training/

Documentation for QGIS 3.22
Official documentation of QGIS. Available 
in various languages and versions. Also 
available to download for offline reading.
https://docs.qgis.org/3.22/en/docs/index.ht
ml
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Having established the priorities for the  
SUMP, the parameters that are 
important for each index can be 
selected and relevant data categories, 
sources and metrics can be identified to 
quantify these.
The table shows an example of 
spreadsheet of SUMP priorities/ indexes 
and relevant data that define key 
parameters for each index, developed in 
Step 1. This creates the framework for the 
analysis and will be further developed in 
Step 4, to establish a score for each index. 

The parameters and metrics used to 
quantify these can vary, based on the 
requirements of different cities and data 
availability. For example, other relevant 
land uses/ points of interest can be 
included; the walking distances can be 
adjusted to reflect different walking 
catchments i.e. 5-, 10-, 15-minute walk etc; 
different pedestrian accessibility radii can 
be used. Detailed description of the Spatial 
Accessibility and Metric Catchment 
Analysis is provided in Step 2 Spatial 
Modelling in this Manual.

At the end of the toolbox process, the 
relevant index parameters will be 
aggregated to provide a final score for each 
segment in a single spatial model (Step 4), 
will be visualised (Step 5), and will be used 
to highlight the current performance of the 
city, priority areas, areas for intervention 
etc (Step 6).

Data Parameters Priorities/ Indexes

Data categories Data name Data 
source

Metrics Walkability Cyclability Active 
travel

Sustainable 
tourism

Road Centre Line model OpenStreetMap data Source

Vehicular accessibility

Pedestrian accessibility

Cycle accessibility

Important and existing 
crossings

‘Shared map’ Source

No. of important and existing crossings 
within 5min walk

Existing car parking 
locations

No. of existing car parking locations 
within 15min walk

Tourist attractions (active 
travel)

No. of tourist attractions (active travel) 
within 15min walk

Other main tourist 
attractions

No. of other main tourist attractions 
within 15min walk

Open space No. of open space within 15min walk

Social facilities No. of social facilities within 15min 
walk

Health facilities No. of health facilities within 15min 
walk

Primary schools and 
kindergartens

No. of primary schools and 
kindergartens within 15min walk

High schools No. of high schools within 15min walk

Cycle path understudy Access to cycle path within 5min cycle

Bus stops

KTEL ‘Bus 
stations/stops’ Source

No. of bus stops within 5min walk
KTEL ‘BUS STOPS 
CHANIA-AGIA 
MARINA -
PLATANIAS-
KOLIBARI’

Source

Hotels OpenStreetMap data Source No. of hotels within 15min walk
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Create a project folder. 

Create a subfolder called ‘data’ to 
save all the downloaded data.

The table shows an example of a list 
of data collected in the Platanias
study. 

It is recommended to create and 
maintain a similar list in an excel 
spreadsheet as a record for future 
reference.

Recording the data categories and 
their data source is useful to evaluate 
what data is available. This will then 
be used to help develop SUMP 
analysis priorities and indexes.

Data categories Data name Source Format Geometry type Link to data 
source

Road Centre Line model OpenStreetMap data Geofabrik Shapefile Line http://download.geofabri
k.de/europe/greece.html

Important, existing and 
proposed crossings
Existing, possible and 
foreseen car parking 
locations
Bus transit centre 
proposal
Tourist attractions 
(active travel)
Other main tourist 
attractions
Open space and 
possible open space 
creation
Social facilities
Health facilities
Primary schools and 
kindergartens
High schools
Cycle path understudy

‘Shared map’ Municipality of 
Platanias/Technical 
University of Crete

Keyhole Markup 
Language (KML)

Point https://www.google.com/
maps/d/u/0/edit?mid=1G
KJAOZaJP6uu_KWRDu
tpcODsQYiQKtxc&ll=35.
51841232632995%2C2
3.924795884530656&z=
17

Bus stops KTEL ‘Bus 
stations/stops’

Municipality of 
Platanias/Technical 
University of Crete

Keyhole Markup 
Language (KML)

Point https://www.google.com/
maps/d/u/0/viewer?mid=
1wWdZNUJyMGnznuiA
ARi2cyEKf-
8&ll=35.5081809215586
05%2C24.00544294708
256&z=15

KTEL ‘BUS STOPS 
CHANIA-AGIA MARINA 
-PLATANIAS-KOLIBARI’

Municipality of 
Platanias/Technical 
University of Crete

Desktop study Point https://www.e-
ktel.com/en/tourist-
guide/tourist-maps

Hotels OpenStreetMap data Geofabrik Shapefile Point http://download.geofabri
k.de/europe/greece.html

Hotel accommodations 
municipality capacity

www.platanias.gr PDF N/A https://www.platanias.gr/
xenodochiaka-
katalymata-dimou/
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This step produces the two 
key types of analysis Spatial 
Accessibility Analysis (SAA) 
and Metric Catchment 
Analysis (MCA) using Space 
Syntax open-source tools. 

This will provide an 
understanding of the role 
of the spatial network in the 
mobility patterns at different 
scales and types of movement 
- vehicle, cycle, pedestrian -
and the metric catchments of 
specific locations within the 
network. 

This initial analysis highlights 
potentials and challenges in 
terms of active travel, purely 
based on the spatial 
characteristics of the street 
network and the location of 
specific points of interest.   

Overview
The Spatial Accessibility Analysis 
(SAA) and Metric Catchment 
Analysis (MCA) describe urban 
form characteristics, linked to the 
functional performance of a city.

SAA and MCA are developed using 
the Space Syntax Toolkit for QGIS. 

The following five tools from the 
Space Syntax Toolkit for QGIS are 
used to process the analysis:

Road Network Cleaner
Network Segmenter
Graph Analysis
Attributes Explorer
Catchment Analyser

Metric Catchment Analysis
The MAA measures the ease of 
accessibility of specific locations within 
the network for a specific metric distance. 
The analysis is used to assess which 
parts of the city are within a specific 
distance from key locations and points of 
interest (land use, infrastructure, 
transport node etc).

The street network is used to measure 
walking distances from these key 
locations/ points of interest. Metric 
distance is calculated and converted into 
walking time, where 400m are covered in 
5 minutes (based on a conservative 
walking speed of 1.33m/s).  

Examples of SAA (top) and MCA (bottom) 
visualisations.

Spatial Accessibility Analysis 
Spatial Accessibility measures key 
properties of the urban network, which 
can then be linked to the movement 
potential of an area for different scales. 
The Spatial Accessibility Model is based 
on a unique representation of publicly 
accessible streets and paths. The street 
pattern of an area is transformed into a 
network “graph”. This is divided into 
individual “segments”, each one being the 
street or path between two intersections. 
Each segment is then evaluated using a 
mathematical algorithm to calculate the 
relative spatial accessibility and hierarchy 
of the different parts of the network for 
different scales of movement.

Two measures of spatial accessibility are 
typically used: Integration 1 measures the 
ease of access and identifies centres of 
potential activity and Choice 1 measures 
the passing flow potential and highlights 
which routes are most convenient for 
most journeys, depending on the scale of 
journey (as a proxy for transport mode). 
The two measures reflect the two 
fundamental elements in human 
movement: firstly, the selection of a 
destination, and secondly, the 
selection of a route. 
1 Space Syntax Online Training Platform, 
Glossary, 
https://www.spacesyntax.online/term/integratio
n/
https://www.spacesyntax.online/term/choice/
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Installing Space Syntax 
Toolkit plugin in QGIS and 
relevant tools

Load QGIS 

Select Plugins > Manage and Install 
Plugins…

In the ‘Plugins’ window type ‘Space 
Syntax Toolkit’ in the search bar. 
Select the toolkit from the list and 
Install Plugin. (Figure 1)

The toolkit icons will appear in the 
QGIS toolbar. (Figure 2)

The following five tools from the 
Space Syntax Toolkit plug-in will 
be used:

1. Graph Analysis
Performs Space Syntax analysis by 
remotely connecting to Depthmap.

2. Attributes Explorer
Visualises results of the analysis and 
explores basic statistics.

3. Road Network Cleaner
Simplifies OpenStreetMap Road 
layer to Space Syntax Segment 
Maps.

4. Network Segmenter
Segments the model.

5. Catchment Analyser
Performs Metric Catchment Analysis. 
Cost variable can be changed. 

Space Syntax Toolkit in QGIS

21 3 4 5

Figure 1. Installing Space Syntax Toolkit in QGIS Plugins

Figure 2. Space Syntax Toolkit tool icons in QGIS

D1.6  Space Syntax Simplified Analytical Toolbox Manual  V.02
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Importing OpenStreetMap 
layer or Road Centre Line 
layer into QGIS workspace 
and specifying  Coordinate 
Reference System (CRS).
Load QGIS and create a new project 
(workspace). Save the workspace to 
the main project folder.

Select the Current CRS button, at the 
bottom right hand side of the 
workspace (Figure 3).

Specifying the project CRS
Untick No CRS and type in the Filter 
the area grid name. Always select the 
correct ESPG from Predefined 
Coordinate Reference Systems, in 
Projected Coordinate Systems 
under Transverse Mercator list. Do 
not select projections from the other 
lists. Use the preview window as a 
guide.

If you cannot find the right ESPG, use 
https://epsg.io or 
https://spatialreference.org for 
reference.

Select Apply and OK.

In the example of Platanias study, the 
project CRS is GGRS87 / Greek Grid 
ESPG: 2100 

Adding the OpenStreetMap or Road 
Centre Line data. 
Select Layer > Add Layer > Add Vector 
Layer…
Locate the OpenStreetMap or Road Centre 
Line layer, in Browse from the project data 
folder. Select Add.

All OpenStreetMap datasets are projected in 
a world CRS (WGS 84) which is a geographic 
CRS for the whole world. If you look at the 
map, it may look slightly distorted. This layer 
needs to be reprojected, in order to use the 
project CRS defined earlier (GGRS87 / Greek 
Grid ESPG: 2100 in the Platanias study)

It is recommended that all layers in your 
workspace are saved with the same CRS. To 
do that for OpenStreetMap or RCL layer 
select Layer > Save Vector Layer as…
Select ESRI Shapefile format 
Browse ‘…’ to select the desired location. 
Create a subfolder called ‘shapefile’ There 
you will save all the shapefile layers related to 
the project workspace.

Save as ‘osm_roads_georef’
Select the project CRS from the CRS list 
(GGRS87 / Greek Grid ESPG: 2100 from the 
Platanias study)

Tick Add saved file to map. 
Remove the original OpenStreetMap layer.

Figure 3. Project Properties – CRS window

D1.6  Space Syntax Simplified Analytical Toolbox Manual  V.02
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Using the Road Network 
Cleaner tool to clean 
topological errors and 
simplify angular changes in 
the model. 
This generates a cleaned line model 
layer and an unlinks1 layer, based on 
the principles of an axial map2. 

Run the Road Network Cleaner with 
the appropriate settings (Figure 4).

Specify input layer. This the 
reprojected OpenStreetMap 
osm_roads_georef or Road Centre 
Line model.

Select data source to apply default 
settings and edit default settings if 
necessary.

Select output type shapefile and 
browse ‘…’ to select location. 
Rename to spm_ex_cl

Select to load unlinks. Unlinks are 
automated points. They disconnect 
two axial lines intersecting on the 
axial map, that are not directly 
connected in reality, such as a road 
bridge crossing the road.

Select to load errors. The errors 
highlight where angular changes 
were simplified, and where parallel 
lines have been merged into a single 
line.

Then select Run. The new layers will 
appear in the Layers panel.

The Road Network Cleaner outputs
(Figure 5), will have three elements:
1. A typologically cleaned map, 

layer name ending _cl (polylines 
angularly simplified and parallel 
lines merged into a single line 
towards the principles of an axial 
map)

2. Unlinks with layer name ending 
_cl_u (blue points)

3. The topological errors that 
have been fixed layer name 
ending _cl_errors (pink points)

Space Syntax Toolkit in QGIS

Figure 4. Road Network Cleaner window

Figure 5. Road Network Cleaner outputs

1 Space Syntax Online Training Platform, 
Glossary,
https://www.spacesyntax.online/term/axial-
unlink/

2To learn more about axial map and the 
representations of space, see Space 
Syntax Online Training Platform. 
https://www.spacesyntax.online/applying-
space-syntax/urban-methods-
2/representations-of-space/
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Checking and editing the 
primary network and unlinks 
file in the cleaned spatial 
model.
This ensures that the key 
routes/spaces are represented 
correctly and no key routes are 
missing.
Modelling axial lines
Axial or road-centre lines must be the 
longest and fewest lines necessary 
to represent spaces in a model. 
The segment map should have:
• The fewest possible segments to 

avoid redundant representation of 
spaces

• The smallest angular changes 
between segments to minimise 
angular changes between spaces.

To accomplish that you MUST model 
primarily as axial lines. However, if 
there is an existing intersection snap 
the axial line to intersection to avoid 
creating unnecessary trivial rings.

Key conventions of modelling, using 
axial lines are shown in Figure 6.

• Lines should be drawn as straight 
as possible.

• Avoid creating small lines that 
add more segments in a graph. 
Space in the model should not be 
over-represented. If a route or 
direction in space can be replaced 
completely by following other 
segments, with no important 
angular cost added, it means that 
specific segment is not necessary in 
the model.

• Simplify angular changes 
between segments and prioritise
the foreground over the background 
network. Unnecessary acute angles 
will increase the cost in calculations 
based on angular distance.

• Do not draw polylines. Lines 
should have only 2 endpoints.

• Map needs to be segmented 
afterwards (see p.21).

Updating the foreground network 
(primary spatial network)1

The foreground network of the model 
and the unlinks should be checked and 
manually updated, as required, 
following the key principles and 
conventions of modelling axial lines. 

To make edits, always save a copy of 
the cleaned model and unlinks layer 
created in the previous step. Create a 
copy called spm_ex_cl_edited and 
spm_ex_cl_u_edited

1. Prepare a background map
• Use an OpenStreetMap background 

in OpenLayers plugin (Web > 
OpenLayers plugin > 
OpenStreetMap > OpenStreetMap) 
and follow the primary network (i.e
long routes though the city).

• You can also use 
QuickMapServices plugin (Settings 
– Get contributed pack)

• Use road classification information 
to highlight the primary network (if 
present)

• Use Google Street View if 
necessary.

1 To learn more about the foreground 
network, visit the Space Syntax Online 
Training Platform.
https://www.spacesyntax.online/term/foregr
ound-network/

Check how the project CRS changes, as it 
attempts to adjust between different layers 
CRS. You do not need to change the 
projection of OpenStreetMap raster 
layer. If you remove the layer, you can 
change the project CRS.

Move the OpenStreetMap raster layer to 
the bottom of your Layer panel.
You can also add any basemap data 
layers that you may have for visualisation. 
Open-source OpenStreetMap Geofabrik
region folder downloads usually contain a 
zip folder of buildings, railway tracks, water 
etc. If they are up to date and applicable for 
the project, make sure when the layers are 
imported into the workspace they are 
resaved with the project CRS.

2. Check and edit, as required, the 
primary spatial network (see key editing 
tools on p.20)
• Model as axial lines.
• Simplify parallel lines.
3. Check and edit, as required, unlinks 
(points – snap to intersection – 1m buffer) 
(see key editing tools on p.20)
• Model as points.
• Snap to intersection.
• Use 1m buffer.

If the foreground has a very big number of 
representational errors, it is easier to 
redraw it from scratch. 

Wrong

Right

Figure 6. Conventions of modelling axial lines
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Checking and editing the 
secondary network in the 
cleaned spatial model.

Updating the background network 
(secondary spatial network)1

The checking/ editing of the 
background network should be 
focused within a specified distance 
from the project site/ study area. 
This depends on the local radius 
of the analysis.

1. Prepare a background map
• Use an OpenStreetMap / Google 

Maps background from 
OpenLayers / QuickMapServices
plugin.

• Use Google Street View if 
necessary.

• Go for a site visit (if possible).

2. Create a site point layer to set the 
centre of the site/study area
• Select Layer > Create Layer > New 

Shapefile Layer
• Click on Browse ‘…’ and locate the 

project folder. Save as ‘site_point’
• Select ‘Point’ as Geometry type.
• Select the project CRS.
• Select OK.

• In the Maps workspace, find the 
point of the centre for the analysis. 
This can be the centre of the 
site/study area.

• To add a point, select the 
‘site_point’ layer and click on the 
Toggle Editing then Add Point      
Feature. 

• Left click the centre of the study 
area in the workspace, then click 
‘OK’ in the Feature Attributes 
window. 

• Click the Toggle Editing button in 
the toolbar to save the layer. Click 
Save button to save the workspace.

3. Buffer the site point by double the 
radius of your local analysis.
• To create a radius buffer, select
• Vector > Geoprocessing Tools > 

Buffer… 
• Select ‘site_point’ as the Input layer. 

The Distance is double the radius of 
your local analysis. In the example 
Platanias study,the local analysis 
radius was (pedestrian accessibility) 
was 1200m or15min-walk, therefore, 
the buffer for this was 2,400m. 

• Type the value in metres.
• Select ‘Run’. 

The temporary Buffered layer will 
appear in the Layers panel. To save, 
select the temporary layer in the Layers 
panel and select Layer > Save As… 

The ‘Save Vector Layer As…’ window 
will appear. 

Select ‘ESRI Shapefile’ as the Format.
Select the project CRS. 
Click on the Browse ‘…’ button and 
locate the project folder. Save as 
‘site_point_distance_buffer’.

Move this layer below the network 
model in the Layer panel.

Delete the temporary Buffered layer.

4. Check and edit spatial network 
within the buffer (see key editing 
tools on p.20).
• Start modelling from the site and 

towards the edge of the buffer
• Model as axial lines.
• Simplify angular changes of existing 

lines.
• Simplify lines that over-represent 

spaces.
• Add lines where connections are 

missing.
• Delete connections if they no longer 

exist.
• Edit unlinks if necessary.

1 To learn more about the  background 
network, visit the Space Syntax Online 
Training Platform.
https://www.spacesyntax.online/term/backg
round-network/
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Editing
Drawing tools

Select the layer and click toggle 
editing        to start editing the layer. 
When in editing mode, you can use 
the following tools:

Add Feature To add missing     
connections or redraw lines.
Delete Selected To delete 

connections that no longer exist and in 
order to redraw them.

Node Tool To change the 
alignment of a line.

Save changes frequently.
Make sure you Save Layer Edits as 
frequently as possible, as QGIS might 
crash.

Snapping settings
Snapping settings are extremely 
important to avoid creating 
disconnections in your model.

Snapping options can be found in 
Project > Snapping Options…

Follow the rules below.

Never snap to segment or to 
segment and vertex as it creates 
disconnections.

Axial model
Snap to Off

Snapping is disabled

Segment model  
Layer selection Active Layer
Snap to Vertex
Tolerance 10.00 px
Enable Topological Editing

Use Enable Topological Editing 
setting to check if all lines are 
snapped to an intersection

Unlinks
Layer selection All Layers
Snap to Vertex
Tolerance 10.00 px
Enable Snapping to Intersection
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Common errors: 
Points & NULL geometries
• Coinciding points: While using 

the node tool, if you double click a 
node you will make a coinciding 
point with no length. You can 
manually check for these using 
select by expressing running 
$Length = 0

• NULL geometries: using the node 
tool you might also create invalid 
geometries. You can select them 
using select by expression 
running $geometry is NULL and 
delete them.
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After processing, the outputs from the 
Network Segmenter (Figure 8) will 
load into the Layers panel:

Segment map layer name ending with
_seg

Break points layer name ending with 
_seg_breakpoints, containing:
• Break points: the points where the    

lines have been segmented
• Stubs: specify in which cases these 

endpoints are removed (when > 40% 
of the total length) 

• Invalid unlinks: specify in which 
cases they are invalid and how to fix 
each case

Invalid unlinks must be checked and 
fixed. Invalid unlinks can be:
• unlinks outside the buffer threshold
• unlinks intersecting more than 2 

lines, no line or only 1 line

Resave a copy of the 
spm_ex_cl_u_edited unlinks layer. 

Rename the layer spm_ex_seg_u. 
Check and fix invalid unlinks 
accordingly to the _seg_breakpoints
layer.

Segmenting the model using 
the Network Segmenter tool.
This tool breaks the lines of the axial 
model (including manual edits from 
previous step) into segments (a line 
between two intersections).  It also 
performs various other validation 
procedures in preparation for the 
analysis.

Run the Network Segmenter and 
change the settings accordingly 
(Figure 7):

Input layer, select the updated, 
simplified and cleaned layer from the 
previous Modelling step. This is 
spm_ex_cl_edited.

Unlinks layer & unlinks buffer (use 
1m), select the unlinks layer produced 
from the simplified and cleaned layer 
and updated in the previous Modelling 
stage. This is spm_ex_cl_u_edited

Make sure remove stubs box is ticked

Select output type shapefile and 
browse ‘…’ to select location. Rename 
to spm_ex_seg

Tick to load break points 
(recommended to check invalid unlinks).

Space Syntax Toolkit in QGIS

Figure 7. Network Segmenter window

Figure 8. Network Segmenter outputs
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Verifying the segment model to 
check for errors using the 
Verify tab in the Graph 
Analysis tool before 
processing the model.
Common errors include: island; orphan; 
invalid geometry; small line; short line. All 
errors need to be fixed before processing 
the model.

Model verification
To run the verification(Figure 9):
1. Open the Graph Analysis tool in 

Space Syntax Toolkit, select the Map
tab and Verify layer tab

2. Select the network layer (layer name 
spm_ex_seg), untick Segment map 
or road centre line and select Verify

3. Go through all errors and fix them 
one by one. Common errors include: 
island; orphan; invalid geometry; 
small line; short line.

Edit or delete islands, orphans and 
invalid geometries. Manually connect 
small and short lines. If there are 
hundreds of short lines, run the model 
with Road Network Cleaner with only 
‘snap endpoints threshold’ selected.

Repeat the verification process, until 
no errors left.

Space Syntax Toolkit in QGIS

1

2

3

Field Calculator tool to update ID

Figure 9. Axial map verification using Graph Analysis tool
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Once all the errors have been fixed, 
update the IDs with the Field 
Calculator tool.

To update IDs (Figure 10):
1. Select the layer in the Layers panel 

and select Field Calculator in the 
toolbar. The Field Calculator 
window will appear.

2. Select Create a new field.
3. In the Output field name, type ‘id’
4. Select the Output field type as 

‘Whole number (integer)’
5. Double click row_number under 

Variables in the Functions list, or 
type @row_number into the 
Expression box.

6. Click OK. 
7. Click Toggle Editing in the 

workspace toolbar to save the 
layer.

2

Field Calculator tool

3
4

5

6

1

Figure 10. Update segment IDs using the Field Calculator
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Verifying the unlinks to 
check for errors using the 
Verify tab in the Graph 
Analysis tool before 
processing the model.

Unlinks verification (Figure 11)
1. Open the Graph Analysis tool in 

Space Syntax Toolkit, select the 
Map tab and Verify layer tab

2. Select the network layer (layer 
name spm_ex_seg with no errors 
and updated IDs)

3. Select the Unlinks tab, and select 
the corresponding unlinks layer 
(layer name spm_ex_seg_u
checked and fixed with manual 
editing and Network Segmenter)

4. Select the Settings button to 
change the verification settings.

Unlink crossing threshold is used to 
buffer a point on an intersection 
(recommended 1m). Use the same 
unlinks crossing threshold as the 
unlinks buffer in the Network 
Segmenter.

Error Fix

Multiple lines
Single lines
No lines

Move the unlink 
to the 
intersection of 
two lines. If not 
relevant delete 
them

Same id Click Update IDs

Unmatched id Click Update IDs

Space Syntax Toolkit in QGIS

Table 1. Type of ID errors and how to 
fix the errors

Figure 11. Unlinks verification – verify and update unlinks ID using Graph 
Analysis tool

1

2
3 4
5
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5. Click Update IDs the first time you 
run the unlink verification. The ids 
of the unlinked lines are stored in 
attributes called line1 and line2. 
The first time unlinks verification 
runs, it checks if the line1 and line2 
attributes are present. If these 
attributes are missing the user is 
asked to run Update IDs to assign 
the id of the lines at the 
intersection identified by each 
unlink.

6. Go through the errors and fix them 
as suggested in the Table 1, on the 
right.
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Using the Graph Analysis tool 
to process the model and 
produce the Spatial 
Accessibility Analysis (SAA)
The results must be visualised and 
validated after the analysis is finished.

Downloading and opening 
depthmapXnet
Download depthmapXnet from the link 
at the bottom of the Graph Analysis tool 
(Figure 12). 

Unzip the depthmapXnet folder, and 
open the depthmapX application. 

This application needs to be open in 
the background in order to run 
Graph Analysis. 

Once opened, you do not need to do 
anything in depthmapX.

Radius (m) Metric

400 Pedestrian Accessibility (5min walk)

800 Pedestrian Accessibility (10min walk)

1,200 Pedestrian Accessibility (15min walk)

2,000 Pedestrian Accessibility (20min walk)

5,000 Cycle Accessibility

10,000 Vehicular Accessibility

Standard Spatial Accessibility measures

Space Syntax Toolkit in QGIS

Table 2. Spatial accessibility standard measures 

Figure 12. Select layers and change settings to process a model for angular 
segment analysis using Graph Analysis tool

≈≈
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Running the Graph Analysis in 
QGIS
In QGIS, run Graph Analysis and 
change the settings accordingly 
(Figure 12):

• In the map tab, select the 
segmented layer to be analysed. 
The map MUST be already 
segmented. This is the verified 
layer name spm_ex_seg

• Tick segment map or road centre 
line.

• In the unlinks tab, select the unlinks 
layer. This is the verified layer 
name spm_ex_seg_u

• In the depthmapX remote tab, 
type in the analysis radii (typically 
1200, 5000, 10000, see Standard 
Measures Table 2, on the right) 
and change the output table name 
(use _p)

• Click Calculate.
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A message will appear when 
processing is completed (Figure 13).

The processed shapefile will 
automatically be added as a new 
layer in the workspace.

Space Syntax Toolkit in QGIS

Figure 13. Processed angular segment analysis 

≈≈

≈≈ ':
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Using the Attributes Explorer 
to visualise the Spatial 
Accessibility Analysis.
Click the Attributes Explorer tool in 
the Space Syntax Toolkit.

Select the processed layer from the 
drop down list, and select Refresh.

The processed map will immediately 
get visualised, using a default style.

In Numeric attributes, scroll down till 
you reach the NACH measures. 
(Figure 14) Click on NACHr10000m. 
The processed map will be visualised 
to show the result of NACHr10000m. 

In the Symbology tab, select Classic
colour range. Change the Width / Size 
to 1.00.

Click on Apply Symbology to apply 
the selected style.

Right click the layer in the Layers 
panel and select Properties…

In the Layers Properties window, 
change the Classes from 10 to 16 
(Figure 15).

Space Syntax Toolkit in QGIS
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≈
≈

Figure 14. Using Attributes Explorer tool to visualise the processed map

Figure 15. Layers Properties window 
to adjust Classes
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Applying the Spatial 
Accessibility Analysis 
standard ranges for 
visualisation.
To set up the standard colour 
ranges (for NACH measures only), 
double click on Values and change 
each range to have the specific 
values shown in Figure 16.  

Select Apply to apply the standard 
colour ranges.

Save the style for future use, by 
selecting Style > Save Current 
Style… to open the Save Layer 
Style window.

In the Save Layer Style window, click 
on the Browse ‘…’ button and locate 
the project folder. 

The standard colour ranges for 
Spatial Accessibility Analysis (NACH 
measures only) is now saved.

The style can be loaded from the file 
location, by Style > Load Style…

Figure 16. Layer Properties and Save Layer Style window to set up Spatial Accessibility Analysis 
standard colour range
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Using the Attributes Explorer 
to explore statistics for 
selected measures and to 
create charts.

There are statistical features in the 
Attributes Explorer. They can be 
exported as part of data analysis and 
documentation in step 5.

Stats

Click the Stats tab. A statistical 
summary for the selected measure are 
displayed. (Figure 17)

Space Syntax Toolkit in QGIS
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Figure 17. Using Attributes Explorer tool to explore the statistical summary of selected measures
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Charts

Histogram
Click the Charts tab. Select 
Histogram. 

Histogram of the distribution of the 
values of the selected measures is 
displayed. Mouse scroll button can 
be used to zoom in and out. (Figure 
18)

Space Syntax Toolkit in QGIS
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Figure 18. Using Attributes Explorer tool to explore the histogram distribution of selected measures
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Scatter plot
Choose first measure (x axis) from the 
Numeric attributes.

Select Scatter plot in the Charts tab. 
(Figure 19)

Choose the second measure in Y axis.

The scatter plot will automatically 
update, with calculated correlations. 
They are:
r -Pearson’s coefficient
r2 - linear regression
Line formula 

Select Regression line to display the 
regression line on the scatter plot.

Use the mouse scroll button to zoom in 
and out of the scatter plot.

Click the ‘A’ at the bottom left corner to 
return to default zoom.

To save the charts, right click the 
graph area.

Click on Export…

The Export window will open. Select 
File format to save image.

Change Export options, such as 
background colour, according to 
preference.
Click Export.

Space Syntax Toolkit in QGIS
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Figure 19. Using Attributes Explorer tool to explore and export scatter plot correlations between two measures
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Using the Catchment Analyser 
tool, to produce the Metric 
Catchment Analysis from 
various points of interest.
The analysis uses the street network to 
assess which parts of the city are within 
a specific distance from key locations 
and points of interest (land use, 
infrastructure, transport node etc).

To run metric catchment analysis, 
import in the workspace all relevant 
parameter layers identified in Step 1 
Inception, i.e. specific types of land 
uses, social infrastructure, open spaces, 
pedestrian and cycling infrastructure, 
transport etc. These will be the origins 
for each metric catchment analysis.

The origin layers need to be a point 
geometry type layer in order to run 
metric catchment analysis. If any of 
the variables have geometry type that 
are polygon or polyline/line, then follow 
the next steps to convert to points.

An example of data with polygon 
geometry type could be the land use 
data, often using the building polygons. 

Another example of data with 
polyline/line geometry type could be 
cycle routes.

Converting polygon to point
This creates a point centroid for each 
polygon.

Select Vector > Geometry Tools > 
Centroids… (as seen in Figure 19)

Select the polygon layer in Input 
layer.

Select Create centroid for each part, 
and click Run.

A temporary layer will appear in the 
Layers panel. Save the new layer in 
the project folder.

Converting line to point
This create points at every vertices of 
the polyline/line.

Select Vector > Geometry Tools > 
Extract Vertices… (as seen in 
Figure 20)

Select the line layer in Input layer.

A temporary layer will appear in the 
Layers panel. This creates points for 
polyline/line vertices. Save the new 
layer in the project folder.

Space Syntax Toolkit in QGIS

Figure 19. Converting polygon to point using Centroids geometry tool

Figure 20. Converting lines to point using Extract Vertices geometry tool

Polygon 
layer

Polyline/ 
line layer
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To run the metric catchment analysis, 
select Catchment Analyser tool in the 
Space Syntax Toolkit.

The Catchment Analyser window will 
appear. (Figure 21)

1. Select network layer – this is the 
processed segment model 
spm_ex_seg_p

2. Select network cost as length

3. Select origins as the origin layer. 
The origins are the parameter layers 
identified in Step 1 Inception and 
converted to point geometry type layer 
(previous page). 

In the Catchment Analyser, Settings

4. Enter value for the cost band e.g. 
400 
which represents 400m, 5min walk
Only enter the numeric value in the 
cost band.
Refer back to the Step 1 Inception, as 
the measures for each variable have 
been  evaluated when producing 
SUMP analysis priorities.

Standard measures are shown in 
Table 3, on the right. 

5. Select shapefile as the Output 
layers.

6. Select the Browse button to save 
the file. Rename the layer 
mca_project name_origin
name_time_distance

In the example Platanias study, the 
first metric catchment analysis layer 
name is;
mca_pl_important and existing 
crossings_5min walk_400m

where ‘mca’ is metric catchment 
analysis
‘pl’ is Platanias, the project name
‘origin name’ is important and existing 
crossings
‘time’ is 5min walk
‘distance’ is 400m

7. Tick to generate lines and 
polygons.

8. Select Run.

1

2

3

4

5
6

7
8

Metric catchment 
(m)

Walking time

400 5min walk

800 10min walk

1,200 15min walk

2,000 20min walk

Metric catchment 
(m)

Cycling time

1,200 5min cycle 
(average speed 
12km/h)

MCA Standard measures

Space Syntax Toolkit in QGIS

Figure 21. Catchment Analyser window Table 3. Metric catchment (m) standard 
measures
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The results of the metric catchment 
analysis are automatically loaded as 
lines and polygons. 

The standard colour ranges are 
automatically applied. 

The polygon layer will have _plg
saved at the end of the layer name. 

This is the Metric Catchment 
Analysis. The analysis can be 
exported using Print Layout. (See 
Step 5 Exporting and visualisation)

Right click the metric catchment model 
in the Layers panel. Select Open 
Attribute Table.

The min_dist column is the data for 
the minimum distance to the 
closest origin. (Figure 22)

Using the Catchment Analyser tool, 
repeat metric catchment analysis for 
each parameter/ origin layer. 

Make sure to select shapefile as 
output layers, to save both lines 
and polygons layer.

Space Syntax Toolkit in QGIS

≈≈

Figure 22. Metric catchment analysis loaded as lines and polygons. Metric catchment analysis model Attribute table 
showing ‘min_dist’ column
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Examples of outputs/ index 
parameters:
• How many schools, health facilities, 

open spaces and other social 
infrastructure and amenities can be 
accessed within a 15-min walk from 
each segment?

• How many bus stops are there within 
a 5-min walk from each segment?

• How many pedestrian crossings are 
there within a 5-min walk from each 
segment?

• How many tourist attractions and 
accommodations can be accessed 
within a 15-min walk from each 
segment?

• Can a cycle path be reached within a 
5-min cycle from a specific segment? 

Platanias study example
The diagrams on the right show the 
‘Primary school and kindergarten’ point 
layer and the Metric Catchment Analysis 
polygon layer for 1,200m corresponding 
to a 15-min walk (Step 2 output). 
As shown in Figure 24, the street 
segments that are within the red 
boundary - defined by the overlapping 
catchments - have access to two 
primary school and kindergarten within a 
15-min walk. The blue boundary 
catchment area has access to one 
primary school and kindergarten within a 
15-min walk.

This step integrates the 
processed spatial models 
and other datasets into a 
single spatial model. All the 
parameters of the indexes 
are aggregated onto each 
segment of the spatial model 
to calculate the final scores 
in Step 4. 

This allows to calculate the 
number of points of interest 
within specific metric 
catchment from each 
segment of the model and to 
produce a combinational 
analysis of user focused 
outputs. 

The analysis highlights areas 
that have access to facilities 
and areas with few or no 
facilities that have potential 
to improve.

How to visualise the analysis 
is explained on page 42.

text

a.

Figure 23. Metric catchment 
polygons (1,200m) from primary 
schools and kindergartens 

b.

a.

b.

Figure 24. Segments within the 
red boundary (overlapping 
catchments) have access to two 
schools.

Figure 25. Access to primary school and kindergarten – aggregated per 
street segment to show the number of primary school and kindergartens 
that can be accessed from every street segment within 15min walk

a.
b.
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Calculating number of points 
of interest within a specific 
metric catchment from each 
segment of the model 

Duplicating the processed Spatial 
Accessibility model
It is important to make a copy and 
resave the processed Spatial 
Accessibility  model. This is to avoid 
the possibility of creating errors on 
this model during the joining process.

To do this, select the processed 
segment model ‘spm_ex_seg_p’ and 
click on Layer > Save As…

A ‘Save Vector Layer as…’ window 
will appear. 
Select ESRI Shapefile as the Format.
Select the project CRS. 
Click on the Browse ‘…’ button and 
locate the project folder. 
Save as ‘spm_ex_seg_p_copy’

Join Attributes by Location 
(summary)
To integrate the spatial model and 
other datasets, select Processing > 
Toolbox in the toolbar. The 
Processing Toolbox panel will appear 
in the right panel.

Type ‘Join attributes by location 
(summary)’ in the search bar.
Double click Join Attributes by 
Location (summary) from the list to 
open the window.

Select the duplicated processed 
spatial model ‘spm_ex_seg_p_copy’
as the Input layer.

Select a metric catchment polygon 
layer as the Join layer, i.e schools.

In the example Platanias study, the 
‘mca_polygon_pl_primary schools and 
kindergartens_15min_1200m’ layer 
was selected.

Select Geometric predicate 
intersects.

Click on the Fields to summarise 
(leave empty to use all fields) ‘…’ 
button. Select id in this window and 
click on Go back. (Figure 27)

Click on the Summaries to calculate 
(leave empty to use all available) 
‘…’ button.

Select count in this window and click 
on Go back. (Figure 28)

Figure 26. Join Attributes by Location (summary) window

Duplicated 
processed spatial 
model

Geometric predicate 
intersects

Select id

Select count

Locate project 
folder. Save layer 
as ‘project 
name_toolbox_wor
kflow_existing_it1’ 
(where ‘it’ is a 
shortened term for 
iteration)

Figure 27. Fields to summarise 
window

Figure 28. Summaries to calculate 
window
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Click on the Joined layer ‘…’ button.
Locate the project folder. Save layer 
as ‘project 
name_toolbox_workflow_existing_it1’ 
(where ‘it’ is a shortened term for 
iteration)
Select save as type as SHP files 
*.shp

In the example Platanias study this 
layer was named 
‘pl_toolbox_workflow_existing_it1’

Select Run.

The new layer is automatically added 
to the Layers panel.

Right click this new layer and select 
Properties...

Select ‘Fields’ in the left panel. 
(Figure 29)

Scroll down and select ‘id_count’ 
from the list.

The ‘id_count’ column should be 
renamed and unique to each 
variable or land use that is joined to 
the segment model. 

In QGIS, a new field name will only 
save a maximum of 10 characters. To 
maintain consistency in the project, 
rename it no_ex_parameter
where no is number of
ex is existing
parameter is the land use type/ point of 
interest
In the example Platanias study, the field 
name was renamed no_ex_prim for 
number of existing primary schools and 
kindergarten.

Select Toggle editing mode and type the 
joined no_ex_parameter field name. To 
save, select Toggle editing mode again.
Select Apply and OK.

In order to integrate all the parameter 
counts onto a single model, this step 
needs to be repeated for each metric 
catchment polygon layer.

To join more than one variable dataset, 
repeat the ‘Join Attributes by Location 
(summary)’ step. However instead of 
selecting the ‘spm_ex_seg_p_copy’ layer 
as the Input layer, replace the Input 
Layer with the latest joined layer. 

This is a cumulative process. Always 
save and replace the ‘it’ number in the 
new layer name with the number of the 
latest iteration.

Figure 29. Layer Properties window
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Right click the final iteration and 
select Properties...

Select ‘Fields’ in the left panel. 

Check all the joined dataset have 
been saved and renamed (Figure 30).

After each join, a new iteration model 
will automatically be saved and added 
to the Layers panel (Figure 31).

To create the final layer, resave the 
final iteration, and name the layer 
project 
name_toolbox_workflow_existing

In the Platanias study, the final layer 
is called pl_toolbox_workflow_existing

The iterative layers in the 
cumulative process

‘it12’ iteration 12 is the final 
integration of all metric 
catchment polygons to the 
processed spatial model. This 
was resaved as 
‘pl_toolbox_workflow_existing’

Figure 31. Iterative models in the Layers panel in the workspace, 
created as a cumulative process

Figure 30. All joined dataset columns 
in Layers Properties
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Once all the data has been 
combined, NULL values in the data 
table will need to be replaced with 0. 

NULL values are automatically set 
when there are no data from the join 
layer to the input layer. This step is 
important as calculations and 
index parameter settings will not 
perform if NULL values are not 
numerical. 

Select the final iteration of the 
combined model. 

In the Platanias study this was, 
pl_toolbox_workflow_existing

Right click the layer in the Layers 
panel and select Open Attribute 
Table. (Figure 32)

Some of the parameter count 
columns that were recently joined 
contain NULL values in certain 
attributes. 

Close the Attribute Table.

Figure 32. Attribute table showing NULL data in certain joined values 
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To replace the NULL values to 0, 
select the final iteration of the 
combined model in the Layers panel 
and select Open Field Calculator in 
the toolbar. (Figure 33)

In the field calculator window, check 
the Update existing field box.

Select the first variable count field 
from the drop down menu.

In the Platanias study, the first 
variable count field was number of 
existing crossings within 5min walk. 
The field name is no_ex_cros.

To replace the NULL values, an if 
statement is applied. 

IF statement
A single if statement is:
if(condition, result_when_true, 
result_when_false)

Enter the following expression in the 
Expression box:

IF(“fieldname” IS NULL, 0, 
“fieldname”)

replacing fieldname with the actual 
name of the field.

In the Platanias study, this was

IF(”no_ex_cros” IS NULL, 0, 
“no_ex_cros”)

The condition is that the selection 
value must equal to NULL. So that, 
results when true, will equal to 0, 
and when false the condition will 
return the existing data value.

Select OK and select Toggle Editing 
in the toolbar to save the updates.

In order to replace NULL values to 0 
for all other variable count columns, 
this step of applying the IF statement 
will need to be repeated for each 
variable. 

The IF statement will be revisited and 
implemented in Step 4 - Index 
parameter setting.

The final iteration of the combined 
model with NULL values replaced 
with 0 is the Combinational 
analysis. The colour ranges for the 
analysis (as seen on the next page) 
will need to be applied. This can be 
exported using Print Layout. (Step 5)

Figure 33. Field Calculator using IF statement to replace NULL value with 0
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To visualise the combinational analysis, 
right click the ‘project 
name_toolbox_workflow_existing’ in the 
Layers Panel and select ‘Properties…’

A new ‘Layer Properties’ window will 
appear. Click on ‘Symbology’ on the left 
panel. (Figure 34)

In the first drop down menu, select 
‘Graduated’. 

For ‘Value’ select from the drop down 
menu the number of land use and 
variable to be visualised.

Select ‘Equal Interval’ from the Mode 
drop down. This method will create 
classes of the same size. 

Depending on the data distribution, you 
can change the Classes from 5 to a 
larger number, for example 10. This can 
be changed later in this step to achieve 
the desired style.

Now the values are classified, the line 
weight and colours should be adjusted.

Click on the ‘Symbol’ (line) button. 

The ‘Symbol Settings’ window will 
appear.

Increase the ‘Width’ to 0.86. This can be 
changed depending on the final 
visualisation and scale of the exported 
map.

Click ‘OK’. 

Click on the arrow beside ‘Colour ramp’. 
Select ‘All Colour Ramps’. There will be 
a default selection of colour ramps to 
choose from. (Figure 35)

It is possible to create your own colour 
ramp, by selecting ‘Create New Colour 
ramp…’ 

You can also edit existing colour ramps 
by clicking on the ramp colour beside 
‘Colour ramp’. The ‘Select Colour 
Ramp’ window will appear with features 
on how to edit the colours.

Once you are happy with a selected 
colour range, in the Layer Properties 
window, click ‘Apply’ then click ‘OK’.

The model will appear visualised in the 
workspace. It shows the analysis 
aggregated per street segment to show 
the number of land use or other points 
of interests that can be accessed from 
every street segment within a specific 
metric catchment.

Figure 34. Adjusting value, mode classification 
and line weight in the Symbology tab

Figure 35. Adjusting and editing colour ramps in 
the Symbology tab
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In the example Platanias study, the 
number of hotels within 15min walk 
was visualised on the street network. 
The number of hotels range from 0 to 
177.

Right click the layer in the Layers 
panel. Go to ‘Styles’ then select 
‘Add…’

A ‘New Style’ window will appear. 
Name the style, then click ‘OK’. (Figure 
36)

In the example Platanias study, this is 
renamed as ‘no. of hotels within 15min 
walk’

For every field that is visualised, add 
new styles. This is to avoid repeating 
the visualisation process when data is 
already visualised. 

When you have added new styles, you 
can always edit the style. Right click 
the layer, and under ‘Styles’ tab select 
the style name. The style will appear in 
the workspace. Right click the layer 
again, then select ‘Properties…’

Visualising data might require 
testing until the desired style, 
colour ramp and line thickness is 
achieved. 

When visualising other parameters, 
make sure to change the field in 
‘Values’ and classify the ranges 
again under the ‘Equal Interval’ 
mode. This will recalibrate the data 
ranges to this field.

In the example Platanias study, a 
different colour ramp gradient was 
used for counts of each land use type/ 
point of interest. This visually 
differentiates the different counts..

An example of how the data is 
exported and visualised into a report is 
shown in the next two pages (Figures 
37 and 38). The top images show the 
Metric Catchment Analysis for touristic 
attractions and hotels up to 1.2km, a 
Step 2 Spatial Modelling output). The 
images below show the number of 
touristic attractions and hotels within 
15min walk from each segment in the 
model. The analysis shows access to 
these facilities (Step 3 Combinational 
analysis output).

The number of touristic attractions are 
highlighted in a pink gradient, and the 
number of hotels are highlighted in a 
purple gradient. This visually 
differentiates the land use.

Figure 36. Adding and viewing a visualisation Style in the 
workspace

≈≈

≈≈
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Figure 37. Example Platanias study showing Metric Catchment Analysis and 
Combinational analysis

Figure 38. Example Platanias study showing Metric Catchment Analysis and 
Combinational analysis
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Cropping the model to 
reduce loading time and 
better manage the data table
Once the final iteration of the 
combined model named project 
name_toolbox_workflow_existing has 
been produced with all the data  
joined and NULL values replaced to 
0, it is recommended to crop the 
model into a smaller area.

There are two methods that the 
model can be cropped without losing 
data. This is either by a specific 
radius or by municipality/ city/ 
administrative boundary lines. 

Cropping the study area should 
only be applied when all the 
analysis and joins have been 
processed. This method does not 
involve any further processing. It is 
for data organisation and 
management.

Study area by radius
Use the previously created site_point
layer. This was created in the Step 2 
Spatial Modelling, on page 19.
Use this point layer to create a radius 
buffer.

To create a radius buffer, select

Vector > Geoprocessing Tools > 
Buffer… (Figure 39)

Select ‘site_point’ as the ‘Input layer’. 
The ‘Distance’ is dependent on the 
study area. Type the radius value in 
metres.
Change the ‘Segments’ to 50.
Select Run. 

The temporary Buffered layer will 
appear in the Layers panel. 
Select the temporary layer in the 
Layers panel.
Select Layer > Save As…
The ‘Save Vector Layer As…’ window 
will appear. 
Select ESRI Shapefile as the Format.
Select the project CRS. 
Click on the Browse ‘…’ button and 
locate the project folder. Save as 
‘site_point_distance_buffer’ 

Site point layer as 
created in Step 2, p.19

Distance dependent 
on the study area. 
Type the radius value 
in metres.

10,000m 
radius buffer

Site point

Figure 39. Buffer window and output of 
a 10,000m radius buffer
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Study area by boundary
As part of the data collection stage, 
municipality or city boundary data might 
have been collected. This can be used 
to crop a study area by geographic 
boundary.

1. Polygon layer
If the boundary shapefile is a polygon 
layer, select the shapefile and select 
the boundaries in the workspace using 
Select Features by Area or Single 
Click. Selected polygons will be 
highlighted in yellow. (Figure 40)

Using Select Features by Area or 
Single Click, select the geographic 
boundary polygons that you wish to use 
as a study area boundary. 

To select more than one polygon, press 
the shift button on the keyboard and 
select.

Select Layer > Save As…

The ‘Save Vector Layer As…’ window 
will appear. 

To resave only the selected boundaries 
as a new layer, select ‘Save only 
selected features’ under Encoding. 
(Figure 41)

Click on the Browse ‘…’ button 
beside the File name box. Find the 
project folder in File Explorer. Type 
‘study_area_boundary’ in the File 
name and select Save.

The boundary shapefile will appear in 
the Layers panel.

Figure 40. Select Features by Area or Single Click with multiple selected 
polygons highlighted in yellow

Figure 41. Save Vector Layer as… 
window– Saving the selected polygon 
features only

Select Features by Area or Single 
Click

Polygons selected 
highlighted in yellow
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2. Line layer
If the boundary shapefile is a line 
layer, then the layer needs to be 
converted into polygon. 
To do this select

Processing > Toolbox

Type in the Processing Toolbox 
search bar Polygonize. Double click 
on Polygonize under Vector 
Geometry (Figure 42). 

The Polygonize window will appear.

Select the boundary line layer in 
Input layer and then select Run.

A temporary polygonised layer will 
appear in the Layers panel. 
Select the temporary layer in the 
Layers panel.
Select Layer > Save As…
The ‘Save Vector Layer As…’ 
window will appear. 
Select ESRI Shapefile as the 
Format.
Select the project CRS. 
Click on the Browse ‘…’ button and 
locate the project folder. Save as 
‘study_area_boundary_polygons’ 

The line layer is now converted into a 
polygon layer. Refer to the previous 
‘Polygon layer’ step to select specific 
boundaries to clip your model with.

Figure 42.Using Polygonize to convert boundary lines to polygons
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The shapefile will now appear in the 
Layers panel.

Remove the temporary layer from the 
Layers panel.

Croppping selected study area 
using the Clip function
To clip the model with all analysis joined 
by the study area, there is an algorithm 
function called Clip. To do this, select

Vector > Geoprocessing Tools > 
Clip… (Figure 43)

The Clip window will appear, as shown 
on the right. 
Select the model with all joined analysis 
as the ‘Input Layer’. 
Select either the study area by radius 
(circle polygon) or study area by 
boundary (boundary polygon) created 
in the previous step as the ‘Overlay 
layer’. 

Select Run. 
The temporary shapefile will appear in 
the Layers panel. 

Select the temporary shapefile. 
Select Layer > Save As…
The ‘Save Vector Layer As…’ window 
will appear. 
Select ESRI Shapefile as the Format.
Select the project CRS. 
Click on the Browse ‘…’ button and 
locate the project folder. Save as 
‘project 
name_toolbox_workflow_existing_cr’ 

Select project 
name_toolbox_workflow_
existing

Select the study area 
crop by radius or crop 
by boundary layer

Figure 43. Clip window
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Examples of models with all data 
integrated and cropped by radius 
(Figure 44) or by boundaries (Figure 
45). 

The cropped model will aid in data 
management and organisation, 
specifically in the next step of setting 
up index parameters.

In the Platanias study, Figure 45, the 
boundary highlighted in black was 
used.

The four boundary polygons selected 
are municipality boundaries covering 
Platanias and its surrounding area.

The segment model in dark red is the 
Platanias model with all analysis 
joined. This is the 
‘pl_toolbox_workflow_existing’ layer.

By using the ‘Clip’ function, the 
model was cropped by the boundary 
of polygons. This cropped the model 
into a smaller study area, to manage 
and clean the Attributes data table.

The cropped model was saved with 
the layer name 
‘pl_toolbox_workflow_existing_cr’

Figure 44. Radius buffer from site_point (left) and  clipped model by radius buffer (right)

Figure 45. Selected boundaries (left) and clipped model by selected boundaries (right)
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This step defines the 
parameters and aggregates 
final scores for each index, 
based on the priorities set 
out in Step 1. 

Following the aggregation of 
all data/ index parameters 
onto each segment of a 
single spatial model in Step 
3, in Step 4 the parameters 
are:

- normalised and scaled 
from 0 to 1, to ensure that 
all parameters have the 
same range of values 

- weighted, with either 0 or 
1 based on the 
importance of each 
parameter for the specific 
index

- aggregated to provide a 
final index score for each 
segment within the 
model.

Normalised values of 
parameters between 0 
and 1.

Values of parameters for each 
segment, integrated in a single 
model in Step 3 (combinational 
analysis).

Se
gm

en
t I

D
s

Parameter weight 
(1 or 0)

Se
gm

en
t I

D
s

Walkability 
index 
score

Figure 46. Attribute tables from QGIS showing the parameter values 
for each segment, the normalised values, the parameter weights and 
the aggregated walkability index score for each segment in the spatial 
model.
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Normalising index 
parameters to ensure they 
have the same range of 
values.
Before calculating the final index score 
as a sum of all parameters, each 
parameter needs to have the same 
range. This prevents one parameter 
from being overly influential, especially 
if it is measured in different units.

Click the ‘project 
name_toolbox_workflow_existing_cr’ 
shapefile in the Layers Panel and 
select Open field calculator in the 
toolbar. The Field Calculator window 
will appear (Figure 47).

Select ‘Create a new field’.

In ‘Output field name’, type 
“norm_parameter_name” where ‘norm’ 
indicates this is a normalised data 
column.

In the example Platanias study, each 
parameter field starts with ‘no’. This 
indicates ‘number of’. However, as the 
field name character has a maximum 
of 10 characters, it might be better to 
omit this information, so that the new 
fields are easier to distinguish.

When creating new fields, always update 
the list of shortened field names with their 
longer description in the spreadsheet 
reference document.

Select ‘Decimal number (real)’ in the ‘Output 
field type’ drop down menu.

Type ‘10’ in the ‘Output field length’ criteria 
box and the ‘3’ in the ‘Precision’. This 
controls the number of decimal places to 
three decimal places.

The Expression box is where the 
normalisation formula will be applied.

As this is a new column, none of the data 
columns generated from the analysis will be 
overruled.

Type ‘norm’ then the spatial 
measure or variable name in 
the Output field name. The 
‘norm’ indicates this is a 
normalised data column.

Select ‘Decimal number 
(real)’.
Type ‘10’ in the Output field 
length.
Type ‘3’ in Precision.

Select ‘Create a new field’

Figure 47. Field Calculator to create new normalised spatial measure and data 
variable fields  
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Copy the normalisation formula in 
the Expression box 

(“field_name” -
minimum(“field_name”)) / 
(maximum(“field_name”)-
minimum(“field_name”))

Replace “field_name” with the 
appropriate parameter field name. 
Check the “field_name” is the same 
name throughout in the formula.

The parameters in the data table can 
be found in the middle list of drop 
down values, under ‘Fields and 
Values’.

Double click the field name to be 
normalised in the field list. This will 
appear in the Expression box.

Alternatively, typing the field names 
directly in the Expression box will also 
work. When typing the field name, a 
drop menu will appear as a prompt. 
However if there is a typo or incorrect 
spelling, the formula will not work.

In the example of Platanias study, 
Figure 48, the new field is the 
normalisation of the number of 
crossings parameter, named 
‘no_ex_cros’. 

After the formula is updated into the 
Expression box, check there is a 
Preview value in the bottom left 
corner. 

If the Preview displays ‘NULL’ or 
‘Expression is not valid’, there could 
be a mistake in the normalisation 
formula. Check before proceeding to 
save the new field.

Click ‘OK’ and then click on ‘Toggle 
Editing’ in the toolbar to save the 
new field.

Check the new column is saved in 
the Attribute Table, and the values 
are between 0 to 1. 

This step of creating a new 
column and applying the 
normalisation formula will need to 
be repeated for each parameter.

Once this is completed, right click the 
layer and open the Attribute Table. 
Check that all the raw values 
processed from the analysis have 
their corresponding normalised 
columns.

Make sure ‘Toggle editing’ is off and 
the layer is saved.

Figure 48. Field Calculator to normalise parameters from 0 to 1, in the 
newly created normalised fields 
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Figure 49 shows the parameter fields 
and normalised values in the 
example of the  Platanias study 
Attribute table. 

The field names starting with ‘norm’ 
are the normalised fields.

Normalised values 
of parameters 
between 0 and 1 
(Step 4).

Figure 49. Columns in the Attribute table showing actual values of parameters (highlighted in red), and normalised values of 
parameters from 0 to 1 (highlighted in blue) for each segment in the model.

Values of parameters 
for each segment, 
integrated in a single 
model in Step 3 
(combinational 
analysis).Se

gm
en
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D

s
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Weighting parameters based 
on their importance for a 
specific index.
A weight of 0 for not important and 1 
for important is applied (Refer to 
SUMP priorities and key parameters 
set up in Step 1 Inception to define 
this).

In the example Platanias study, the 
indexes developed from SUMP 
priorities were walkability, cyclability, 
active travel and sustainable tourism. 

The walkability index in the Platanias
study the important parameters include 
pedestrian accessibility, no of 
pedestrian crossings, no of social 
infrastructure (schools, health 
institutions) and access to public 
transport (i.e. no of bus stops) etc. 
and, therefore they have a weight (1).  
Cycle accessibility and access to cycle 
paths parameters had a weight of (0) 
for the walkability index, however, they 
had a weight of (1) for the cyclability 
index. 
To create the index fields, click on the 
‘project 
name_toolbox_workflow_existing_cr’ 
in the Layers Panel. 

Click Open Field Calculator in the 
toolbar. (Figure 50)

Select Create a new field. 
In the Output field name, type ‘index 
initial_parameter’

In the example Platanias study, this 
was
w_veh_acc
where the first character symbolises 
the index and the spatial measure 
comes after. 
For instance, the
w represents walkability and
veh_acc represents vehicular 
accessibility.
When creating new fields, always 
update the list of shortened field 
names with their longer description in 
the spreadsheet reference document.

In Output field type select Decimal 
number (real) from the drop down 
menu.
In Output field length, type ‘10’, and in 
Precision type ‘3’.

In order to set up the index table, you 
will need to refer back to the SUMP 
analysis priorities in Step 1. 

Type either ‘0’ or ‘1’ for the 
importance.
Click OK and save the layer by clicking 
the Toggle editing button.

Figure 50. Field Calculator to create index parameter fields
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In the example Platanias study, it was 
evaluated in Step 1 that vehicular 
accessibility is not important to 
Walkability. It has an importance value 
of 0. Therefore, in the Expression box, 
the value entered was ‘0’ for this field.

This will need to be repeated for 
each spatial measure and variable. 

If your project assesses more than 
one index, then this step needs to 
be repeated for each spatial 
measure and variable, for each 
index. 

Save the layer every time a new 
field is created.

Referring back to Step 1 for the 
Platanias study, the next spatial 
measure field in the Walkability index 
is pedestrian accessibility. This new 
field name is labelled  w_ped_acc. As 
agreed in the SUMP analysis priorities 
this measure is regarded as important 
for Walkability, therefore the selection 
value for this field is 1. The complete 
Walkability index has been added to 
the model and can be viewed in the 
Attribute Table, as seen in Figure 46. 
The following field names for 
Walkability are w_cyc_acc, 
w_ex_cross, w_ex_carpa etc.

If you are assessing more than one 
index, assign a unique initial or 
abbreviation for each index.

In the example Platanias study there 
are four indexes. They are;
w_parameter_name
c_parameter_name
at_parameter_name
st_parameter_name

where w represents walkability
c represents cyclability
at represents active travel, and
st represents sustainable tourism.

The index table that was developed in 
step two is now integrated into the 
model layer in QGIS.

Figure 51. Example Platanias study Attribute table view showing Walkability 
index parameters added to the model

Field names starting with ‘w’ indicate the fields are the index values for 
Walkability.

The values should be 1 for important Walkability parameters, and 0 for not 
important Walkability parameters.

The importance of each parameter, for a specific index/priority was evaluated 
and developed in Step 1 Inception.
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Once all the index parameters have 
been added and saved to the model, 
they can be viewed in the Attribute 
Table. 

In Figure 52, it shows the Platanias
study example Sustainable tourism 
index parameters.

For ease of viewing and to check if 
there are errors in the parameter 
values, click on Switch to form view 
in the bottom right of the Attribute 
table window.

Sustainable 
tourism index 
parameters 
weighted

‘Switch to form 
view’ button

Figure 52. Example Platanias study Attribute table view showing Sustainable 
tourism index parameters added to the same model
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Display the Attribute table in a form 
view to check the parameter 
weights are correct and in line with 
the SUMP priorities and indexes 
developed in Step 1 (Figure 53).

If there is an input error, click on 
Toggle editing mode. Select the 
parameter field name that needs to be 
corrected from the drop down menu.  

Type ‘0’ or ’1’ in the input box to 
correct the selection value. Select 
Update All. You will see the 
parameter value number change. 

To save, select Toggle editing mode. 

To go back to the main Attributes table 
viewing mode, select Switch to table 
view.

Walkability 
selection

Cyclability 
selection

‘Switch to table 
view’ button

Figure 53. Attribute table displayed in form view
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Calculating final index score 
for each segment by 
aggregating the normalised 
values of the weighted/ 
important parameters.
In the example of Platanias study, for 
the Walkability index, pedestrian 
accessibility is important and has a 
selection value 1. Therefore, the 
normalised spatial measure for 
pedestrian accessibility will be 
aggregated into the total Walkability 
score. 

When there is a variable that is not 
important to the Walkability index, 
such as vehicular accessibility, the 
normalised spatial measure will not be 
included in the aggregated score. 
Instead it will return 0 value. 

To calculate the aggregated score, 
multiple ‘if statement’ is applied. 

IF statement
A single if statement is:
if(condition, result_when_true, 
result_when_false)

The condition is that the selection 
value must equal to 1. So that, results 
when true, will equal the normalised 
spatial measure, and when false will 
equal to 0. 

In order to calculate the score, the if 
statement will need to be applied to all 
spatial measures and form an 
aggregation that makes up the index.

Select the ‘project 
name_toolbox_workflow_existing_cr’ 
layer.

Click ‘Open Field Calculator’ in the 
toolbar. (Figure 54)
Select ‘Create a new field’. 

In the Output field name, type the index 
name. In the Platanias study, this was 
‘walkabilit’. (Cannot name it ‘walkability’ 
as field names have a maximum of 10 
characters)

In Output field type select ‘Decimal 
number (real)’ from the drop-down 
menu.
In Output field length, type ‘10’, and in 
Precision type ‘3’.

The index selection values and 
normalised parameters in the data table 
(created in the previous steps) can be 
found in the middle list of drop-down 
values, under ‘Fields and Values’.

Double click the field name in the field 
list. The field name will appear in the 
Expression box.

Figure 54. Field Calculator to set up index fields
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The multiple if statement in the 
Expression box is

if(“index_parameter_name_A” IS 1, 
”norm_parameter_name_A”, 0) + 
if(“index_parameter_name_B” IS 1, 
”norm_parameter_name _B”, 0) + 
if(“index_parameter_name_C” IS 1, 
”norm_parameter_name_C”, 0) + …

where the sum (+) between each if 
statement is the aggregation 
process. (Figure 55)

Check there are no mistakes in the 
syntax. Check spelling, punctuation, 
each index selection and normalised
field in the if statements are 
corresponding in variables.

Highlight the statement in the 
Expression box, Copy and Paste into 
a word processing document or 
notepad. This is to reference, copy 
and manipulate other aggregating 
score of indexes in the project.

Click on ‘OK’ and click the ‘Toggle 
editing’ button to save.

This step will need to be repeated 
for each index. Save the layer 
every time a new field is created.

Multiple if statements to 
aggregate a final score of 
index
To calculate walkability in the 
example Platanias study, all 
the fields starting with ‘w’ are 
selected. If the field is 
important to walkability, the 
normalised value will be 
aggregated into the index.

If the field is not important to 
walkability, no value from 
that field will be aggregated 
into the index.

If the Preview displays ‘NULL’ 
or ‘Expression is not valid’, 
there could be a mistake in the 
if statement formula. Check 
before proceeding to save the 
new field.

Figure 55. Field Calculator to calculate multiple IF statements to aggregate a 
final score of index
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Metrics Walkability

Vehicular accessibility 0

Pedestrian accessibility 1

Cycle accessibility 0

No. of important and existing crossings within 5min walk 1

No. of existing car parking locations within 15min walk 0

No. of tourist attractions (active travel) within 15min walk 0

No. of other main tourist attractions within 15min walk 0

No. of open space within 15min walk 1

No. of social facilities within 15min walk 1

No. of health facilities within 15min walk 1

No. of primary schools and kindergartens within 15min walk 1

No. of high schools within 15min walk 1

Access to cycle path within 5min cycle 0

No. of bus stops within 5min walk 1

No. of hotels within 15min walk 0

If importance is 0, then return 0

If importance is 1, then return normalised 0 to 1 NACHr1200m values

If importance is 0, then return 0
If importance is 1, then return normalised 0 to 1 number of important and existing crossings within 5min walk

If importance is 1, then return normalised 0 to 1 number of open space within 15min walk

If importance is 1, then return normalised 0 to 1 number of social facilities within 15min walk
If importance is 1, then return normalised 0 to 1 number of health facilities within 15min walk

If importance is 1, then return normalised 0 to 1 number of primary schools and kindergartens within 15min walk
If importance is 1, then return normalised 0 to 1 number of high schools within 15min walk

If importance is 1, then return normalised 0 to 1 number of bus stops within 5min walk

Important to walkability 
• Pedestrian accessibility
• No. of important and existing 

crossings within 5min walk
• No. of open space within 

15min walk
• No. of social facilities within 

15min walk
• No. of health facilities within 

15min walk
• No. of primary schools and 

kindergartens within 15min 
walk

• No. of high schools within 
15min walk, and

• No. of bus stops within 5min 
walk

What is the formula calculating?

If importance is 0, then return 0

If importance is 0, then return 0
If importance is 0, then return 0

If importance is 0, then return 0

If importance is 0, then return 0
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Open the Attribute table. The index 
field is now saved into the layer.

Figure 56. Example Platanias study Attribute table view showing final score of index for Walkability (highlighted in red)

Parameter 
weight (1 or 0)

Se
gm

en
t I

D
s

Walkability 
index score
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As mentioned before, it is useful to 
save the if statement Expression into a 
word processing or notepad software. 
The expression can be applied to build 
other indexes. 

When creating other score of indexes, 
the normalised field names in the if 
statement will not change. Only the 
condition will change, as the spatial 
measures importance change based 
on the index. 

In the example Platanias study, the 
expression for Cyclability is similar to 
Walkability. The only difference is the 
‘w’ in the condition field was replaced 
with ‘c’. This indicates the Walkability 
selection fields are replaced with 
Cyclability selection fields.

A useful tip is to have the list of ‘Fields 
and Values’ opened. This makes it 
easier to reference and check the field 
names are correct in the Expression. 
This is important if you are assessing 
more than one index, as the index 
selection field names might differ.

The result when true and result when 
false fields do not change. Only the 
condition will change, as the spatial 
measures importance change based 
on the index. 

Figure 57. Field Calculator to create other score of indexes

When creating scores for 
other indexes, the 
normalised field names in 
the if statement do not 
change
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Once all the indexes have been 
aggregated, open the Attribute table 
to check if the fields have been 
saved properly. (Figure 58)

In the example Platanias study, 
walkability, cyclability, active travel 
and sustainable tourism were 
assessed.

Now that the final score of indexes 
have been calculated, they should be 
visualised for analysis.

This is the indexes for the SUMP 
PLUS analysis. The colour ranges 
will need to be applied before the 
analysis is exported using Print 
Layout. (Step 5)

Figure 58. Example Platanias study Attribute table view showing final score of index for Cyclability (highlighted in green), 
Active travel (highlighted in blue) and Sustainable tourism (highlighted in orange)
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This step produces the 
visualisation of the final 
scores of the indexes.

To visualise the indexes, the cropped 
model where the index parameters 
were defined should be selected.

Right click the ‘project 
name_existing_toolbox_cr’ in the 
Layers Panel and select Properties… 
The Layer Properties window will 
appear. Select Symbology.

For ‘Value’ select from the drop down 
menu the index to be visualised.

Once selected, make sure to classify 
the ranges again with ‘Equal Interval’ 
mode and the number of Classes. 
This will recalibrate the data ranges to 
this field, and will appear updated in 
the workspace. (Figure 59)

In the example Platanias study, the 
index selected is ‘walkabilit’. This field 
represents the walkability.

Visualising data might require testing 
until the desired style, colour ramp 
and line thickness is achieved. 

In your study, you may want to 
maintain a colour range to be applied 
across all indexes. However, it is 
important to classify the ranges every 
time a new field is visualised.

Once a style is set, make sure to 
save the style under the ‘Styles’ tab.

Alternatively, you can use the 
Attributes Explorer tool to 
visualise the indexes. (Figure 60) 
The Classic colour range can be 
applied in the same style across all 
indexes.

Using the Attributes Explorer also 
provides an interface to quickly 
assess the differences between 
the indexes. 
It is important to remember the 
threshold and data distribution are 
not the same across the indexes. 
You will see the top values change in 
the Attributes Explorer when you 
change from one index to another.

Figure 59. Data ranges classified and visualised in the workspace using the 
Symbology tab in Layer Properties window

Figure 60. Attributes Explorer tool to visualise the indexes

Attributes 
Explorer 
to 
visualise 
indexes

Data range in 
Equal Interval 
mode, 
classified into 
10 classes.

Data field 
visualised in 
the 
workspace 
according to 
the 
classification 
and style
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Exporting visualised data 
using the Print Layout
The next step is to create a Print 
Layout template to export the 
visualised data.

There are many features in Print 
Layout. One main feature is to set a 
paper size and export a scaled map. 
Additional features, such as adding a 
legend, scale bar and north point are 
optional. This depends on the Print 
Layout design and the style 
developed for reporting and analysis.

Print Layout - Set paper size 
and add a scaled map
In the workspace, click on ‘Project’ 
then ‘Layout Manager…’

The ‘Layout Manager’ window will 
appear.

Under ‘New from Template’ select 
‘Empty Layout’, and then click on 
‘Create…’

The ‘Create Print Layout’ window will 
appear.

Type the name of the print layout. 
Example print layout names could be 
‘zoom-out’, ‘zoom-mid’ and ’zoom-in’ 
indicating the zoom extent and scale of 
the map. 

Once the title is set (you can always 
go back and edit the title), click ‘OK’. 
The new print layout window will 
appear (Figure 61).

To change the paper size, right click 
the centre of the board and select 
‘Page Properties…’

The ‘Page Size’ properties will appear 
in the right hand panel. The page is 
defaulted to A4 landscape. Click on 
the ’Size’ and ‘Orientation’ drop down 
menu to adjust based on your project.

To add the map from the workspace, 
click on ‘Add Map’ button on the left 
panel.

Left click and drag the cursor from the 
top left corner to the bottom right 
corner to create a bounding box. The 
workspace will appear on the page. 
This is ‘Map 1’. What is currently 
displayed in the workspace, will 
appear in ‘Map 1’. The map in the 
Print Layout will update itself, when the 
workspace view is updated.

To move the map and its bounding 
box, click on ‘Select/Move item’ and 
move bounding box. This allows the 
box to be moved around the page.

To edit the map zoom, select 
‘Select/Move item’ and click on the 
map. Select ‘Move item content’. 
This allows the map to be dragged 
and moved within the bounding box.

When ‘Move item content’ is 
selected, the ‘Main Properties’ for 
‘Map 1’ is displayed on the right 
panel. Here you can edit the scale of 
the map.

Once the scale is confirmed, click 
once outside the page to deselect 
‘Move item content’. This locks the 
scale and ensures there are no 
accidental changes to the scale and 
zoom.

Click the ‘Save’ button to save the 
Print Layout template.  

To learn more on Print Layout 
features, such as adding legend, 
scale bar and north point, visit the 
Documentation for QGIS here:
https://docs.qgis.org/3.22/en/docs/us
er_manual/print_composer/composer
_items/index.html

‘Add Map’

‘Select/Move item’
‘Move item content’

Figure 61. Print layout window
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This step produces and 
evaluation of the results in the 
context of and to inform the 
development of SUMP 
measures. 

This is based on the 
visualisation of the indexes, 
which helps to highlight the 
priority areas, the easy wins 
and the areas lacking in the 
facilities, active travel 
infrastructure or spatial 
accessibility and inform the 
decision-making process and 
policy planning. 

Following the diagnosis of the 
existing conditions, a number 
of scenarios can be tested and 
objectively compared and 
assessed through the scoring 
of the indexes of the 
combinational analysis 
(feedback loop in workflow 
diagram).

Examples of how the results 
of the analysis can inform 
the SUMP development
The walkability index analysis can 
highlight an area with a high number 
of social facilities or tourist attractions 
that lacks public transport and 
pedestrian infrastructure, and, 
therefore, has a relatively low 
walkability score. This could help to 
establish this as a priority area for 
improvements, compared to other 
areas with a similar walkability score.  

An area with relatively high 
walkability levels, can be suitable for 
locating a tourist attraction, a school, 
a new open space etc. or it can be 
further strengthened by adding a 
missing connection or a pedestrian 
crossing, or by improving the public 
realm conditions. This can be used 
as a basis to plan a network of tourist 
destinations that can be accessed 
via public and active travel modes. 
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Example of Walkability 
index analysis for the 
diagnosis of the existing 
conditions in Platanias. 

The figure shows the Platanias
walkability output created with the 
Simplified analytical toolbox. The 
table below outlines the spatial 
measures and their importance to 
walkability.

Reporting the score in a table with 
the visualisation clearly outlines the 
measures that are aggregated into 
the index.

When interpreting the data, you may 
notice outliers or error in the data. 
This is common in data analytics, 
and reiterates the toolbox iterative 
process.

Following the diagnosis of the 
existing conditions, a number of 
scenarios can be tested and 
objectively compared and assessed 
(feedback loop in workflow diagram). 

The next step explains the process.

Existing_Platanias Importance*
Vehicular accessibility 0
Pedestrian accessibility 1
Cycle accessibility 0
No. of important and existing crossings within 5min walk 1
No. of bus stops within 5min walk 1
No. of existing car parking locations within 15min walk 0
No. of hotels within 15min walk 0
No. of tourist attractions (active travel) within 15min walk 0
No. of other main attractions within 15min walk 0
No. of open space within 15min walk 1
No. of social facilities within 15min walk 1
No. of health facilities within 15min walk 1
No. of primary schools and kindergartens within 15min walk 1
Access to cycle path within 5min cycle 0
No. of high schools within 15min walk 0

Walkability

high

low

*where 0 is not important and 1 is important
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Depending on the type of the 
modification that needs to be tested, 
different parts of the workflow need to 
be repeated.
For modifications to infrastructure 
(i.e. land use, public transport, new 
pedestrian crossings etc.) Step 2 
Metric Catchment Analysis will need 
to be updated.
This applies if there are:
• No changes to the street network
• Additional parameters.
• Proposed new infrastructure

For modification to street network
(i.e. a new connection or realignment 
of an existing route) both the Step 2 
Spatial Accessibility Analysis and 
Metric Catchment Analysis will need 
to be updated. 

For modification to street network 
and infrastructure 
both the Step 2 Spatial Accessibility 
Analysis and Metric Catchment 
Analysis will need to be updated.

Further scenario testing will 
generate new data. 
It is important to create a copy of the 
original unprocessed segment model 
and original parameters points, before 
making modifications
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Further scenario testing will generate 
new data in Step 2, and, therefore, 
the following steps (3-6)  in the 
workflow should be repeated.
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Based on the findings from the 
existing analysis, recommendations 
for a proposed interconnection was 
highlighted in the Platanias study. 

The image on the left shows the 
walkability index for the existing 
conditions. The model on the right 
shows the walkability index in the 
future scenario, with modifications to 
both the street network and 
infrastructure. 

This considers possible and 
proposed infrastructure such as 
crossings, and a new bust transit 
centre (provided by MU/TUC) and 
the proposed interconnection.

The values and colour ranges have 
been recalibrated based on the 
future scenario model, as the future 
scenario model has higher ranges. 
By applying the same data and 
colour ranges, the two outputs can 
be comparable.

The future scenario shows the 
impact of the proposals on the 
walkability of Platanias.  

Platanias Importance* Future scenario changes
Vehicular accessibility 0 Proposed interconnection
Pedestrian accessibility 1 Proposed interconnection
Cycle accessibility 0 Proposed interconnection
No. of important and existing crossings within 5min walk 1 Proposed crossings

No. of bus stops within 5min walk 1 Proposed bus transit 
centre

No. of existing car parking locations within 15min walk 0
No. of hotels within 15min walk 0
No. of tourist attractions (active travel) within 15min 
walk 0

No. of other main attractions within 15min walk 0
No. of open space within 15min walk 1 Possible creation
No. of social facilities within 15min walk 1
No. of health facilities within 15min walk 1
No. of primary schools and kindergartens within 15min 
walk 1

Access to cycle path within 5min cycle 0 Proposed interconnection
No. of high schools within 15min walk 0

Walkability
high

low

Existing scenario Future scenario

Proposed interconnection

Proposed bus transit centre
Proposed crossings

*where 0 is not important and 1 is important

The future scenario testing  
shows that by implementing 
future scenario changes, such as 
the proposed interconnection, 
proposed crossings and bus 
transit centre in Platanias, the 
walkability index increases 
around the main route, PEO 
Kissamou Chanion.

PEO Kissamou Chanion PEO Kissamou Chanion
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Another example use of further 
scenario testing for the Platanias
study is shown on this page.  

The model on the left shows 
sustainable tourism index for the 
existing conditions. The model on the 
right shows the sustainable tourism 
index in the future scenario, with 
modification to the street network 
and infrastructure. This considers 
possible and proposed additional 
infrastructure provided by MU/TUC 
and the proposed interconnection.

The values and colour ranges have 
been recalibrated based on the 
future scenario model, as the future 
scenario model has higher ranges. 
By applying the same data and 
colour ranges, the two outputs can 
be comparable.

The future scenario shows the 
impact of the proposals on 
sustainable tourism.

Platanias Importance*Future scenario changes
Vehicular accessibility 0 Proposed interconnection
Pedestrian accessibility 1 Proposed interconnection
Cycle accessibility 1 Proposed interconnection
No. of important and existing crossings within 5min walk 1 Proposed crossings

No. of bus stops within 5min walk 1 Proposed bus transit 
centre

No. of existing car parking locations within 15min walk 0 Possible and foreseen
No. of hotels within 15min walk 1
No. of tourist attractions (active travel) within 15min walk 1
No. of other main attractions within 15min walk 1
No. of open space within 15min walk 1 Possible creation
No. of social facilities within 15min walk 0
No. of health facilities within 15min walk 0
No. of primary schools and kindergartens within 15min 
walk 0

Access to cycle path within 5min cycle 1 Proposed interconnection
No. of high schools within 15min walk 0

Sustainable tourism
high

low

Proposed interconnection

Proposed bus transit centre
Proposed crossings
Possible creation of open space
Possible and foreseen parking 
locations

Existing scenario Future scenario

*where 0 is not important and 1 is important

The future scenario testing  
shows that by implementing 
future scenario changes, such 
as; the proposed 
interconnection, proposed 
crossings, bus transit centre, 
possible and foreseen parking 
locations and possible creation 
of open space in Platanias, the 
sustainable tourism index 
increases in the Kolymvari, 
Tavronitis and Platanias areas.

Platanias Platanias
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https://www.spacesyntax.online

Documentation for QGIS 3.22
Official documentation of QGIS. Available in various languages and versions. Also available to download for offline reading.
https://docs.qgis.org/3.22/en/docs/index.html
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Download links
QGIS (2.14 or above)
https://qgis.org/en/site/

depthmapXnet 0.35 – compiled version used for the Space Syntax Toolkit analysis 
http://archtech.gr/varoudis/depthmapX/?dir=depthmapXnet

depthmapX v.0.8.0 (latest release 2020) – multi-platform software platform to perform a set of spatial network 
analyses designed to understand social processes within the built environment
https://github.com/SpaceGroupUCL/depthmapX/releases/tag/v0.8.0

Space Syntax
Website: https://spacesyntax.com/

Training: https://spacesyntax.com/training/

YouTube channel: https://www.youtube.com/user/spacesyntaxdotcom

GitHub: https://github.com/spacesyntax
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